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Forward: 

This guide has been created for the sole purpose of IT Teams and those providing 

training to end users (train the trainer). As such we have tried to create a guide that 

shows you how to use our product and it’s core functionality in a simple, easy to 

understand way.  

As someone who has had to print huge training guides full of large colour screen grabs 

(which were mainly superfluous), we vowed to create IT training guides that did not 

feature tons of them but were comprehensive in supporting the person using them. The 

help file within the program itself contains the same information but with more 

screenshots (if you like that kind of thing).  

We have split the guides out to focus on the different functions within our bundling 

product. This guide is solely about the court bundling process, which is our most utilised 

aspect. 

Lets get started. 
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Getting Help 
There are various ways you can access help for Zylpha Bundling Solution: 

 

● By pressing the "F1" key while in Zylpha Bundling Solution the relevant help 

page will be displayed. 

● Via the program by accessing the "Help" option on the "Help" menu. 

● From the Start menu, select Programs, then Zylpha Bundling Solution and 

click Zylpha Bundling Solution Help. 

System Requirements 

Below is a list of recommended system requirements to use Zylpha Bundling Solution 

● PC with Intel® Pentium®/Celeron®/Xeon™, AMD K6/Athlon™/Duron™ or 

compatible processor. Processor should be 200MHz with 1GB of RAM 

● .NET Framework 3.5 or later 

● Microsoft® Windows XP or later 

● Adobe Reader or equivalent pdf reader 

 

Contacting Zylpha Support 

Please refer to your contract which will specify the correct escalation and front line 

support procedures for contacting Zylpha support. 

 

Generally, we ask for one sole point of contact within an organisation who can contact 

us on support@zylpha.com which is monitored during normal working hours.  

 

 

 

 

  

mailto:support@zylpha.com
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Creating a new Court Bundle  

This will take you through the various steps required to create a new Court Bundle. 

 

 
 

● Select "Court Bundle" from the menu "File" and then  "New...", as below. 

● From the displayed "Select the Template to be used..." window select the "Don't 

use a Template?" to create a bundle from the default settings. 

● Enter the information required for the front page on the "Case Details" tab. 

● Enter the required sections on the "Sections" tab. 

● Change the "Numbering Styles" on the "Sections" tab as required. 

● Include all the documents required for the bundle and attach them to their section 

on the "Add Documents" tab. 

● Optionally, handle any warnings by viewing the "Warnings" tab. 

● Generate the bundle by clicking "Generate" button on the "Create Bundle" tab. 

Creating a new Court Bundle from a template 

This will take you through the various steps required to create a new Court Bundle using 

a template. 

 

● From the “File” menu select “New…” then “Court Bundle” 

● From the displayed “Select the Template to be used…” window select the 

location of the template you wish to use. Once you have selected the template 

click the “OK” button. 
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● This will open a “New Court Bundle” window with the settings based on the 

values stored in the template. 

● Make the changes you require, e.g. add any documents. Once you have made 

your changes to the bundle you can save and/or generate the bundle. 

 

Open and change an existing Court Bundle 

The various steps required to open and make changes to a Court Bundle: 

 

● Open Court Bundle from the menu "File" then "Open..." and then "Court Bundle", 

as below. 

● This will display the dialog box shown below, locate the bundle you wish to open 

and either double click on the file or select the file and click the "Open" button. 

● To change information for the cover page go to the "Case Details" tab. 

● To change information for the sections go to the "Sections" tab. 

● To change information for the documents go to the "Add Documents" tab. 

● Optionally, any warnings can be viewed via the "Warnings" tab. 

● If you need to generate the bundle go to the "Create Bundle" tab and click 

the "Generate" button. 

Creating a subpage in a Court Bundle 

This page explains how you create a subpage in a Court Bundle. 

 

● Open the Court Bundle that you want to add a subpage to. 

● Click on the "Add Documents" tab and enter the document that you want to add 

as a sub page if it isn't already present. 

● Check the "Sub Page" cell for the required document. If "Sub Page" isn't 

displayed in the tab check the icon at the top of the tab to view the "Bundle Index 

Format" see if "Sub Page" is displayed on the Document tab. 

● When you then generate the bundle the sub page document will be added to the 

index and contents using the sub page pagination rules so as not to affect the 

index items around it. For example if a sub page document was added between 

two documents which have pages "A-1" and "A-2" respectively, the sub page 

document will start its page numbers at "A-1-a", then "A-1-b" and so on. 
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How to define a Template for a Court Bundle 
If you create multiple court bundles that are very similar in their format, e.g. cover page, 

index layouts, sections, etc. You can create a template that has the styling you require 

which you can then use as a basis for a court bundle each time you need to create a 

new one. This will stop you having to repeat the same steps every time you need to 

create a court bundle. 

 

This section details the steps required to create a template to be used for a court 

bundle. You have two choices when creating a template either a new one or from an 

existing court bundle. 

 

To create a new template from an existing court bundle 

If you have a court bundle that already has or is close to the format you require you can 

create a template from the bundle and then tailor it as you require. To do this open the 

court bundle and then in any of the tabs click the  icon which is at the top of the tab. 

 

You will be asked what name you want to save the template as and then the template 

will be created, saved and opened for you to view and amend as necessary. 

To create a new court bundle template 

To create a template from the start you will need to perform the following steps: 

 

 From the “File” menu select “New…” then “Template” and finally “Court Bundle” 

which will open a new court bundle template window. The tabs are very similar to 

the ones you see when viewing a court bundle. 

 On the “Case Details” tab  you can enter the case details which are used to 

create the bundles cover page. 

 The “Sections” tab is where you enter the templates sections, index and 

numbering styles. 

 Any documents that you want to be included in the template are entered in the 

“Add Documents” tab 

 “Create Bundle” tab is where the templates generated options are set. There are 

a couple of items which you can’t access on this tab. You can’t set a “Save as” 

location and there is no button to generate the bundle. 

 

N.B. Any setting made in a template can be overridden in the bundles created from it. 

The template is only a common starting point to speed up the time taken to create 

similar bundles 
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Sort documents in a bundle 

The "Sort Bundle" option is available from the "Add Documents" tab toolbar via the  

icon. The documents can be sorted by clicking this icon, the order you select will affect 

the bundle index when you next generate. 

 

 

By selecting the "Section Order" sort option the documents are sorted in the order the 

sections are listed on the "Sections" tab for the bundle. 

 

Selecting the "Section and Date Order" sort option the documents are sorted in the 

order the sections are listed on the "Sections" tab for the bundle and then in ascending 

order of the Document Date. 

 

Choosing the "User Defined Order" allows you to format the sort to you requirements. 

 

The sort must have "Section" as the main part of the sort, and this is therefore pre-

selected. After that you can select which ever field you want to sort by from the drop 

down list and whether the order for that field is ascending or descending. A field can 

only appear once in the sort and the warning icon is displayed next to the field of a 

repeated entry. 

 

Once you are happy with the selection click the "OK" button to action the sort. The 

"Cancel" button will return you back to the "Add Documents" tab without performing the 

sort. 

Saving a Court Bundle 

This explains how you save a Court Bundle, you can either save a bundle with it's 

current name, i.e. the "Save" option or save it from its current name to another name, 

i.e. the "Save As" option. 

 

● To "Save" the bundle click the icon at the top of the tab. 

● To save the bundle as another name click “File” menu and select “Save As…”. 

● If you select "Save As..." then the "File Dialog" box will be displayed allowing you 

to select the new location and file name for the bundle, click the "Save" button to 

action the save. If the file already exists then a warning message is displayed to 

inform you that you will overwrite this file. 
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Add Documents tab 

The "Add Documents" tab is the place where documents which make up the bundles 

are linked to a section so that they can be positioned in the correct part of the bundle. 

 

There are various right-click options that you can access from the document grid and 

these are described here. 

 

 Icons Description 

 
Delete the 

selected document 

row(s) 

This icon will remove any selected document line(s) 

from the bundle. It will only be selectable when the 

whole line is highlighted, which is achieved by clicking 

on the row header. There is a confirmation message 

displayed to make sure this is the line(s) you want to 

delete.  

 
Move a document 

up or down 

Documents can be moved up or down by selecting a 

document and clicking on either of the icons, depending 

on which way you want the document to go. You can 

also drag and drop the lines. 

 
Sort Documents The documents can be sorted by clicking this icon, the 

order you select will affect the bundle index when you 

next generate. For a more detailed description view the 

Sort a Bundle help. 

 Change the index 

format 

The index pages and document tabs can be formatted 

differently from the default values so you can produce 

the index page you require and view the columns you 

need on the "Add Documents" tab. This allows different 

set ups for different types of bundles. For a more 

detailed description view the Bundle Index Format help. 

 Create a template 

from this bundle 

This will convert the current bundle into a template 

which can be used as a template for other bundles to 

speed up their creation. 

The Document grid's columns are described below, if you can't see a field it will have 

been set as not visible in the tab to view a hidden column click the index button at the 

top of the tab.  
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Section contains a drop down list of all the sections entered on the 

"Sections" tab for the bundle. 

Document Date displays the date which will appear next to the document on 

the index page. The date will default to the document's create 

date when it is added but can be overridden. To select a date 

double click in the cell and the "DatePicker Dialog box" is 

displayed to enable the required date to be selected. You can 

also add text into the date field, this handles situations for 

example when the date is a range, e.g. "01/03/2010 - 

15/03/2010" or "March - May". 

Description contains the description which will appear on the index page 

for the document.  It will be defaulted to the document name 

when it is added. It is easier to edit the description by double 

clicking the cell to view the "Maintain Document Description" 

form. 

Document Path displays the location of the actual document you want to 

include in the bundle. To locate the document double click in 

the cell and the "DocumentPicker" is displayed, locate the 

document then either double click on the document or select it 

and click the "Open" button to add the path to the cell. You 

can also drag and drop files on to the grid see "Drag and Drop 

Documents". 

 

N.B. if the cell is coloured red then the document is of a type 

that bundle can't convert to Pdf, see the "Features" page in 

the Help file for convertible types. If the cell is coloured 

orange then the path to the document is no longer valid. 

Sub Page If this cell is ticked then it signifies that this document should 

be handled as a sub page when it is paginated into the 

bundle. 

User Defined Field 1 This field can be renamed to be used as required by the user 

to help extend the functionality of the index. 

User Defined Field 2 This field can be renamed to be used as required by the user 

to help extend the functionality of the index. 
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Exclude from Index 

Numbering 

Check this field if you don't want this document to be 

numbered in the index, it will be displayed on the index page 

without the numbering prefix. This field is only displayed when 

the "Number Documents in index" is checked on the "Section" 

tab. 

Add Document Right Click menu 

The right click menu is available when you right-click the mouse inside the document 

grid on "Add Documents" tab and any selected rows in the grid will be affected by any 

action selected from the right click menu. 

 

Descriptions from the "Add Documents" tab is shown below. Please note that the 

actions available on the list is dependent on the type of lines you are actioning and 

therefore the list will not always be the same 

 

Move Up Moves the selected row up one row, this is only allowed when one 

row is selected 

Move Down Moves the selected row down one row, this is only allowed when 

one row is selected 

Delete Deletes all the selected rows after you have clicked ok on the 

confirmation screen that is displayed 

View Document Views the selected document,  this is only allowed when one row 

is selected 

Insert a line Inserts a blank line after the last selected line, you will be asked to 

enter the section the blank line will belong to 

Properties... Displays the "Properties" form which allows you to change all 

selected lines on a single form. 

Size Media... Allows you to  set the format of a media file in the bundle. Displays 

the "Set the media properties..." form which allows you to format 

the size of a media file in a bundle. This option is only available 

when the selected line is a media type 

Select Excel 

Worksheet... 

Allows you to select either all the sheets, which is the default, or a 

single worksheet from the spreadsheet. Displays the "Select the 
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worksheet" form which is a list of all the work sheets. This option is 

only available when the selected line is a spreadsheet file type. 

Bundle Index Format 
 

This screen is accessible from the "Sections" and "Add Documents" tab via the icon at 

the top of the tab. Here the user can tailor the layout of the bundles index and the 

columns viewable on "Add Documents" tab. You can drag the start and end points of 

the index fields directly from the form. 

 

 
 

The tab is shown below with descriptions of its features. 

 

 Icons Description 

 Preview Index This will show an example of the index page with the 

settings applied. The only difference from the generated 

bundle is that each index field has a coloured box 

around it to show its size. This will help positioning fields 

and identify overlapping fields. See an example of this 

previewed index page below. 

 Reset index fields to 

defaults 

Click this button to return all the settings to your default 

settings. 

 Set as Default Click this button to make these settings your default 

settings and will be used as your default for all new 

bundle created from this point forward. 

 Manually edit index 

values 

This displays a numeric position of the index fields to 

allow a more precise positioning of the fields 

Print headings in 

the Index? 

when checked causes the index page to also print the column 

headings. 
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The following fields Section, Document Date, Description, Document Path, User 

Defined 1, User Defined 2 and Page Number have similar fields which are described 

below. 

Field Name this text box allows you to rename the fields default name, for 

example "Document Date" might make more sense when called 

"Create Date". Changing this value will mean that the new value 

will appear in the Document tab column heading and the Index 

page heading, if the headings are printed in the index. 

On Tab When checked then this column will appear in the Document tab 

and unchecked it will not. The Section column must always be 

displayed and so this option is checked and can not be 

changed. 

In Index When checked then this column will appear on the Index page 

and unchecked it will not be shown. The Section column must 

always be displayed and so this option is checked and can not 

be changed. Also the "Sub Pages" column is preset to 

unchecked and can not be changed. 

Position (only 

visible from the 

manually edit 

index values) 

This field indicates the start position of the field on the index 

line. The field is only available if the "Visible in Index" field is 

checked and all measurements are in centimeters. 

Length (only 

visible from the 

manually edit 

index values) 

This field indicates the length of the field on the index line. The 

field is only available if the "Visible in Index" field is checked and 

all measurements are in centimeters. There is no Index Length 

field for the Section as this appears on it's own line in the index. 
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Case Details tab 

 

The "Case Details" tab is where the information required to create the cover page for a 

Court Bundle is entered. 

 

The fields Court, Case No., Case Title, Between, Document Title, Party Separator, 

Parties, Extended and Address text take their initial values from settings you enter in the 

"Application Settings" from the "Tools > Preference" menu item. This allows the form to 

be pre-populated to speed up the process but all of these values can either be added to 

or over typed as required. 

 

The "Parties" grid lists the Names of the parties involved, an optional Sub-Line which 

appears below the Name entry on the cover page and their capacity in the case, e.g 

Applicant, Respondent, etc. 

 

Entries in the "Parties" table can be reordered by either dragging and dropping to a new 

position or by right-clicking on the entry and selecting either "Move Up" or "Move Down" 

from the displayed menu. 

 

Parties can be deleted by either selecting the row header (the grey column to the left of 

each row) and pressing "Delete" on the keyboard or by right-clicking on the entry and 

selecting "Delete" from the displayed menu. 
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 Icons Description 

 Save Saves the bundle 

 Preview the cover page This will display a preview of the cover page based 

on the settings in the tab. 

 Create a template from 

this bundle 

This will convert the current bundle into a template 

which can be used as a template for other bundles 

to speed up their creation. 

 Create a Spine Label Will create a spine label based on the cover page 

settings 

Colour Dialog box 
The Colour Dialog box allows you to select the colour you require for either a font or a 

section. Click on the colour you want to use and then click "OK" to select the colour. If 

you want to return without selecting a colour then click the "Cancel" button. 

If you don't see the colour you require then click the "Define Custom Colours" button 

which will extend the dialog box and give you access to a palette where all available 

colours can be selected.  

Create Bundle tab for Court Bundle 

The "Create Bundle" tab is where the bundle is generated using all the information 

entered by the user.  

 

To create the bundle, click the "Generate" button. When this button is clicked there is a 

final check to see if there are any issues with the bundle, e.g. document does not exist. 

If there are, then a message is displayed giving a brief description of where the issues 

are. You are then given the choice to continue generating the bundle or viewing the 

messages. All warnings can be viewed on the "Warnings tab". 

 

There are two types of bundles you can create and they are described below. 

 

Temporary Bundle 

If you want to create a temporary bundle but not save it, you can leave the "Save as" 

box empty and the bundle will be created in a temporary pdf which once closed cannot 

be retrieved except by regenerating. 
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Saved Bundle 

You can create a saved bundle by entering a location in the "Save as" box. Simply click 

in the icon and then the "Save as" file dialog box will be displayed.  Select the location 

and bundle name you wish to use and click the "Save" button. Nothing will be saved to 

this location until you click the "Generate" button to create the bundle. N.B. The "Save 

as" location will be stored with the bundle if you save the bundle at any point. 

There are various options on this tab and they are described below: 

 

 Icons Description 

 Save Saves the bundle 

 Security settings for 

the bundle 

Displays the "Add Security to Pdf document" form to 

allow you to define the security settings for the bundle. 

 Set the watermark Displays the "Set the Watermark options..." form to allow 

you to define a watermark for the bundle 

 Create a template 

from this bundle 

This will convert the current bundle into a template which 

can be used as a template for other bundles to speed up 

their creation. 

 

The following options are available on the main form  

 

 Version Text Any entered text will be added to each of the bundles 

page footers. The version text is positioned on the left 

side of the footer unless the page number has been put 

on the left in which case it is moved to the right. This field 

is optional 

 Include the version 

text on cover page? 

Check this option if you want the version text to be added 

to the cover page(s). 

 Display bundle after 

generating? 

After clicking the "Generate" button, if checked the 

generated bundle will be displayed in your pdf viewer. If 

this field is not checked then the bundle will still be 

created but the bundle will not displayed. 

 Print index pages in 

the bundle? 

To include the index page(s) in the bundle check this 

field, to exclude the index from the bundle simply 

uncheck the field. 
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 Print separator 

pages in the 

bundle? 

To include the separator pages in the bundle check this 

field, to exclude the index from the bundle simply 

uncheck the field. 

 Duplex print ready? To allow duplex printing, this is when you can print the 

bundle double sided, check the option. 

 Add security to the 

bundle? 

To include any security settings you may have entered in 

the generated bundle you will need to check this option. 

 Include a watermark To include any watermark settings you may have entered 

in the generated bundle simply check this option and as 

long as a watermark has been set it will be added to each 

page. 

 Send the generated 

document securely 

By checking this option, when the bundle is generated, 

the resultant bundle is added as a send file in the 

"Secure Delivery" form ready to be sent to its' recipient. 

You can't check this option and redact at the same time. 

 Redact the bundle? Checking this option will send the bundle after generation 

to be redacted. You can't check this option and secure 

delivery at the same time. 
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